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Chapter 1  

Introduction 

Business/Commercial software applications usually have a set of  programs that allow 
the user to input, process, query and output data. These programs typically require a 
high level of  customization, depending on the type of  business, and on clients' 
requirements. It is therefore crucial to have powerful tools, that allow to perform 
these customizations easily and quickly, thus not adding code within the procedures. 

CODEPAINTER REVOLUTION delivers a set of  Visual Tools that allow creating and 
configuring sections of  applications that are likely to be changed often. These tools 
are: 'Query Painter', 'Zoom Painter', 'Dialog Window Painter', 'Report Painter' 
(integrated in the 'Query Painter'), and 'Menu Painter'.
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Chapter 2  

Query Painter 

2.1 Introduction 

The Query Painter is a powerful query and multifile reporting tool that deeply exploits 
the SQL language and works in a Client/Server environment. It replaces all tools that 
have been used so far guaranteeing independence and versatility. Using the Query 
Painter you can define multifile queries that can be called from within the application. 
Data can be extracted (routine procedures), displayed (Visual Zoom), or processed 
through advanced reporting functionalities. The end result is not code to be compiled, 
but complex SQL sentences that are components of  the host application. These 
sentences can be changed or implemented as required, delivering a high level of  
flexibility. 

The Query Painter is highly integrated with the application's Data Dictionary to guide 
the experienced user through complex queries without the need of  deeply knowing 
the application's structure. This renders this powerful tool ease to use. 
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2.2 The Tool 

To open the Query Painter run your application, open the 'Utility' menu, and select 
'Query Painter'. The 'Query Painter' window is divided into three different sections, 
namely 'Dictionary', 'Design', and 'Query'. The tool has also a dedicated toolbar 
(Query Painter). 

 

The 'Dictionary' section details the list of  available files, fields and relationships, that 
build the 'Data Dictionary'. 

The 'Design' section details the relationships between selected files, showing a graphic 
picture of  the query allowing to display files and relationships. 

In the 'Query' section you can define advanced SQL sentences for the query. This 
section is subdivided in tab-strips to define both, SQL options and filter parameters. 
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2.3 The Query Design Toolbar 

The 'Query Design' Toolbar has a set of  buttons that help you interacting with the 
tool: 
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Button Name Action 

 
New To open a new query (.VQR). 

 
Open To open an existing query (.VQR). 

 
Save To save the opened query. 

 
Save As Saves the opened query with a different 

file name (max. 8 characters) 

 
Exit To Exit the query and go back to the 

application. 

 
Execute Query To execute the query. 

 
SQL Sentence To display the SQL sentence. 

 
Create/Modify Report To create/modify the print out of  the 

query. 

 
Create/Modify Mailmerge To create/modify the MS Word 

Mailmerge documents. 

 
Create/Modify Excel Worksheet To create/modify the MS Word Excel 

worksheet. 

 
Create/Modify Graph To create/modify the MS Graph 

worksheet. 

 

2.3.1 New 

The 'New' button clears memory and opens a new query. 
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2.3.2 Open 

The 'Open' button opens an existing query. Clicking this button the 'Open' dialog 
window is opened defaulting the working directory and detailing all existing queries 
(.VQR extention). 

2.3.3 Save 

The 'Save' button saves the current query. The name of  the query can be maximum 
eight characters long. 

2.3.4 Save As 

The 'Save As' button saves the current query with a different name. The name of  the 
query can be maximum eight characters long. 

N.B. 

Queries can be saved under a subdirectory named 'Query'. During the 'Design' phase the system 
will always search for .VQR files under this directory. Before launching a query from a procedure 
you have to define the correct path. For example, if  you launch the query named 'prova' that you 
saved under the subdirectory 'Query', you need to define the path 'Query\prova.VQR'. 

2.3.5 Exit 

The 'Exit' button exits the 'Query Painter' to go back to the application. 
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2.3.6 Execute Query 

The 'Execute Query' button Executes the query. The query result is downloaded in a 
temporary cursor (_TMP_) and can be viewed using the 'View Query' browser. 

N.B. 

The query should always be created using the incremental method, i.e. select a table, define selection 
parameters and test the query using the 'Execute' button; Add another table, define other selection 
parameters and test it again. Doing so you can monitor the query and be sure of  the result you are 
getting. 

2.3.7 SQL Sentence 

The 'SQL Sentence' button displays the SQL sentence. Through this function you can 
check the SQL syntax. 

 

N.B. 

Warning: you can only check the sentence's syntax. You can not control the semantics, which is 
strictly related to the type of  data extraction you want to obtain. 

2.3.8 Create/Modify Report 

The 'Create/Modify Report' button creates or modifies the print out of  the query. 
The report tool can be launched using the selected language in two different ways: 
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If  there is no associated report to the query, the first time the report is launched, the 
report prototype is shown. The prototype can be changed and saved under the same 
name. The next time you launch the report (when both files 'QueryName'.FRX and 
'QueryName'.FRT exist) the report tool is recalled opening the report having the same 
name as the query. Right clicking the button the 'Open' dialog window is opened and 
you can select/create other reports (*.FRX). 

 

If  you digit a file name, which is different from the query name, a new report 
prototype will be created. You can therefore associate more reports to the same query. 

N.B. 

 If  you associate more reports to the same query you need to recall the query using the following 
syntax: 

VX_EXEC with<QueryName>.VQR,[<ReportName>.FRX][PREVIEW]
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2.3.9 Create/Modify Mailmerge 

The 'Create/Modify Mailmerge' button creates or modifies the MS Word Mailmerge 
documents. Selecting this button MS Word is opened, a mailmerge model created and 
saved with the extention .DOC having the same name given to the query. Right 
clicking the button the 'Open' dialog window is opened and you can select/create files 
(*.DOC). 

 

If  you digit a file name, which is different from the query name, a new MS Word 
document will be created. You can therefore associate more documents to the same 
query. 

N.B. 

If  you associate more documents to the same query, you need to recall the query using the following 
syntax: 
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VX_EXEC with<QueryName>.VQR,[<DocumentName>.DOC]

The document's format can be changed to match clients' requirements (envelops and labels, pre 
formatted models, etc.). The mailmerge support databases (_WORD_.DBF and FPT) is saved 
in the MS Windows temporary directory (usually C:\WINDOWS\TEMP). 

During execution the <QueryName>.DOC file is opened and data is 'mailmerged' creating the 
default file CATHALOG1.DOC, which can be printed and saved. When you define the 
document you can apply the various MS Word mailmerge types, e.g. you can execute the mailmerge 
functionality directly on e-mail documents opening the 'Mail Merge' window (in MS Word) and 
selecting the 'E-mail' option. 

2.3.10 Create/Modify Excel Worksheet 

The 'Create/Modify Excel Worksheet' button creates or modifies the MS Word Excel 
worksheet. When you select this button MS Excel is opened, a worksheet created and 
saved with the extention .XLT having the same name given to the query. Right clicking 
the button the 'Open' dialog window is opened and you can select/create files 
(*.XLT). 
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If  you digit a file name, which is different from the query name, a new MS Excel 
document will be created. You can therefore associate more documents to the same 
query. 

N.B. 

If  you associate more documents to the same query, you need to recall the query using the following 
syntax: 

VX_EXEC with<QueryName>.VQR,[<DocumentName>.XLT]

or 

VE_EXEC with<DocumentName>.XLT,<CallingObjectpointer>,<QueryName>.VQR

Where the Calling Object Pointer refers to the document where you want to display the graph, e.g. 
'This' or 'This.oParentObject, etc.). 

N.B. 
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Never use field names that equal a MS Excel cell (e.g. A1, A2, ..., N10, Z99, etc.) in order to 
avoid errors in MS Excel. 

Once MS Excel is opened two documents are created: the prototype document and a 
sort of  preview file, that uses the documents format and contains the query data. You 
must work on the file with the extention .XLT. All changes will be automatically saved 
with the extention .XLS. 

Let us now analyze the document's structure: 

 

In the first row you can see the field names. Following there is an area, which is 
limited by two captions, namely 'BODY' and 'ENDBODY'. The system will add single 
tuples, i.e. the query result, within these two captions. You can now change the file as 
required as to obtain the wanted result. Be aware that only rows between the two 
captions are taken into account and are repeated for each extracted value. 

Saving the 'XLT' format, every time you will launch the MS Excel Worksheet from the 
corresponding query, a new worksheet, which uses the XLT document's style, will be 
created. 
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Exercise 

Le t  us  now c rea te  an  i tem l i s t  conta i n i ng  t he  f o l l ow ing  th ree  f i e l ds :  ' I tem 
No. ' ,  'Des c r i p t i on ' ,  and  '  P r i c e ' .  C rea te  a  query  to  ex t ra c t  a l l  va l ues  
saved  i n  the  f i l e .  Se le c t  a l l  f i e lds  and  change t he  f ie ld  names  i n to  ' I t em 
No. ' ,  'Des c r i p t i on '  and  ' P r i ce ' .  

 

 

 Save  the  que ry ,  t hen c l i c k  the  'C reate /Mod i fy  Exce l  Worksheet '  
bu t ton  t o  l aunch  t he  gene ra t i on  o f  the  p ro to type  sheet .  A f te r  a  few 
seconds  MS Exce l  i s  opened  and  two  f i l e s  c rea ted ,  the  mode l  and  the  
document .  The  la t te r  w i l l  be  f i l l ed  w i th  the  va lues  re su l t i ng  f rom the  
que ry .  
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You can  now  improve  t he  mode l ' s  l ayout  ( .XLT ) .  Changes  w i l l  be  app l ied  
fo r  the  quer i es  tha t  w i l l  f o l l ow .  Improve  the  co lumn  s i z e  so  tha t  the  
des c r i p t i on  f i t  in  the  ce l l s .  Change the  font  co lo r  fo r  t he  f i r s t  row  to  
h igh l i gh t  the  t i t l es .  Go  to  the  ce l l  conta i n i ng  t he  ' To t a l '  and  add a  doub le  
l i ne  on  the  ce l l ' s  top .  Add borde rs  to  the  ce l l s  fo rm ing  the  tab le ' s  heade r  
and  body .  
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Save the  . XLT  f i l e  and  c l i c k  the  'C reate/Mod i fy  Exce l  Worksheet '  bu t ton  
aga in .  As  you can  see  i n  the  nex t  p i c tu re ,  the  changes  you made to  the  
.XLT  f i l e  have  been app l i ed  to  t he  . XLS  f i l e .  
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2.3.11 Create/Modify Graph 

The 'Create/Modify Graph' button creates or modifies the MS Graph worksheet. 
When you select this button MS Graph is opened, a worksheet created and saved with 
the extention .VGR having the same name given to the query. Right clicking the 
button the 'Open' dialog window is opened and you can select/create files (*.VGR). 
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If  you digit a file name, which is different from the query name, a new MS Graph will 
be created. You can therefore associate more graphs to the same query. 

Once MS Graph is opened a graph prototype will be created and the corresponding 
toolbar opened so that you can change the graph's structure and the 'Datasheet', 
where the selected fields are displayed. 
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The graph's format can be changed to match clients' requirements. Each time values 
change the graph will consider these changes. Changes saved on the .VGR model will 
be applied every time when the 'Create/modify MS Graph' functionality is launched. 
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Exercise 

Le t  us  now c rea te  an  i tem l i s t  conta i n i ng  t he  f o l l ow ing  th ree  f i e l ds :  ' I tem 
No. ' ,  'Des c r i p t i on ' ,  and  '  P r i c e ' .  C rea te  a  query  to  ex t ra c t  a l l  va l ues  
saved  i n  the  f i l e .  Se le c t  a l l  f i e lds  and  change t he  f ie ld  names  i n to  ' I t em 
No. ' ,  'Des c r i p t i on '  and  ' P r i ce ' .  

 

 

 Save  the  query ,  then c l i ck  ' C rea t e/Mod i f y  MS G raph '  but ton  to  launch 
the  genera t ion  o f  the  p ro to type  g raph.  A f te r  a  few seconds  MS G raph i s  
opened  show ing  the  g raph ' s  p ro to type  and  the  da ta sheet  conta i n i ng  da ta .  
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You can  now  improve  the  g raph p ro to type  l ayout .  The  f i r s t  f i e l d  s e l ec ted  
in  the  query  i s  u sed  to  id ent i f y  the  va lues  w i th i n  the  g raph and the  o ther  
f ie ld s  a re  the  cor re spond ing  va lues  on  the  ax i s .  Us i ng  the  MS G raph  
too lba r  you  can  now change  the  g raph 's  t ype ,  co lumn co l ours ,  add  
s t r i ngs  and/or  images .  

 

Chang ing  va lues  in  the  'Datashee t '  w indow ,  the  va lues  i n  the  graph w i l l  
be  changed  ac co rd ing l y ,  bu t  these  changes  w i l l  no t  be  saved .  Fu ture  
quer i es  w i l l  a lways  use  the  ac tua l  da ta  s t o red  in  the  tab l es .  

Doub le  c l i ck i ng  the  co lumn header  you  can  show or  h i de  the  co lumns '  
da ta .  S im i la r ly  you  can  show o r  h i de  t he  rows '  da ta .  A f t e r  hav ing  
imp lemented  a l l  r equ i red  changes ,  s ave  the  g raph ' s  la you t  so  tha t  i t  w i l l  
be  u sed  i n  fu ture  quer i es .  To  save  s imp ly  c l ose  the  g raph  and  c l i ck  'Yes '  
on  the  d ia l og  w indow that  fo l l ows .  
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2.4 First Window - Dictionary 

This window shows the list of  files on the left and the corresponding fields on the 
right. At the bottom of  the window the files' relationships are displayed. 

 

2.4.1 Tables 

The 'Tables' section details all tables defined for the application. Highlighting one of  
the tables you can view its fields on the right ('Files of') and its relationships at the 
bottom ('Relations Of'). There are two ways for selecting a table: 

Drag&Drop 

Right click the desired table and drag it to the 'Design' window. Selected tables will be 
displayed also in the 'Query' window in the 'Tables' tab-strip, and vice versa. 
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Double Click 

Double clicking the desired table, it is carried over to the 'Design' window. When you 
select a file, which is related to one or more files the 'Relations' window is activated, 
detailing all relationships, the fields used for the relationship, and the kind of  Joins 
used. 

2.4.2 Fields Of ... 

The 'Fields Of..' section details the list of  fields defined for the highlighted table. 
There are two ways for selecting a field: 

Drag&Drop 

Right click the desired field and drag it to the 'Design' window. The field is added in 
the corresponding table. Selected fields are also displayed in the 'Query' window in the 
'Fields, Group By and Order By' tab-strip and vice versa. If  you select the same field 
twice a warning message appears asking you if  you want to proceed anyway. 

Double Click 

Double clicking the desired field, it IS carried over to the 'Design' window and added 
to the corresponding window. Selected fields are also displayed in the 'Query' window 
in the 'Fields, Group By and Order By' tab-strip and vice versa. If  you select the same 
field twice a warning message appears asking you if  you want to proceed anyway. 

2.4.3 Relations Of.. 

The 'Relations Of..' section details all relationships of  the selected table. Connecting 
fields are displayed in brackets next to the file's name. There are two ways for selecting 
a field: 

Drag&Drop 

Right click the desired relationship and drag it to the 'Design' window. The two files 
will be linked by a yellow line. Similarly the link will be displayed in the 'Query' 
window in the 'Tables' tab-strip and the kind of  relationship in the 'Join' tab-strip. 

Double Click 
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Double clicking the desired relationship, it is carried over to the 'Design' window The 
two files will be linked by a yellow line. Similarly the link will be displayed in the 
'Query' window in the 'Tables' tab-strip and the kind of  relationship in the 'Join' tab-
strip. 

2.4.4 Find Relations 

Selecting a table and clicking the 'Find' button all linked tables are displayed in a new 
dialog window. Let's analyse this functionality through an exercise. 

Exercise 

You  need  to  r e t r i eve  a l l  Agents  wo rk ing  i n  a rea  A .  The tab le s  in vo l ved  i n  
the  que ry  t here fo re  a re  the  ' Agents '  tab l e  and  the  ' A reas '  tab l e .  You do 
not  know whe ther  t he  two tab l es  a re  d i rec t l y  l in ked  or  whether  you need  
to  cons i de r  l i nk s  t o  o ther  tab l es  to  r e t r i eve  Agents  in fo rma t ion .  C l i ck ing  
the  ' F ind '  bu t ton  you can  d i sp lay  a l l  ex i s t i ng  l in ks  be tween the  ' A rea s '  
and  the  ' Agent s '  tab le s .  Th i s  func t i ona l i t y  ana l yzes  the  l in ks  de f ined  i n  
the  'Des i gn '  phase  s ta r t i ng  f rom the  f i r s t  s e l ec ted  tab l e  mak ing  
concent r i c  c i r c les .  The resu l t  i s  subd i v ided  i n  l eve l s :  t he  f i r s t  l eve l  
imp l i es  a  d i r ec t  connec t i on  be tween the  two  tab le s .  The  second l eve l  
means  tha t  in  o rde r  to  reach  t he  des t ina t i on  t ab l e  you need  to  go  
th rough a  th i rd  t ab l e ;  t he  t h i rd  le ve l  requ i res  go ing  t rough a  th i rd  and  a  
fou r th  tab l e ,  and  so  fo r th .  

 

From Table 

The 'From Table' field in the 'Find Relations' window is required to define the table 
from which the link search will start. 

To Table 

The 'To Table' field in the 'Find Relations' window is required to define the target 
table for the link search. 
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The Find Button 

Clicking the Find button within the 'Find Relations' window starts the search. 

2.5 Second Window - Design 

This window graphically show the selected tables, their fields and their links. Clicking 
on one of  the tables you can display it in the first window ('Dictionary'). 

 

2.6 Third Window - Query 

In the 'Query' window you can define advanced SQL options that form the query. 
This window is subdivided in six tab-strips: 
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2.6.1 Tables 

The 'Tables' tab-strip list all tables selected for the query. You can scroll the list using 
the scroll bar on the side. You can change the tables' order simply moving them up or 
down. Right click the button on the left side of  the table, keep the mouse pressed and 
drag the table in the desired position. 

 

Description 

The 'Description' column contains the tables' name. The names used are the ones 
defined during the 'Design' phase. Should the same table be selected twice, a repetition 
number will be added to the table. 

Alias 

The 'Alias' column contains the tables' alias names. These names are the ones defined 
during the 'Design' phase. Should the same table be selected twice, a repetition 
number will be added to the table. 

Table Name 

The 'Table Name' column contains the physical name of  the tables. These names are 
the ones defined during the 'Design' phase. 

Delete Button 

Clicking the 'Delete Button' the selected table is deleted from the list, consequently 
also from the query and from the 'Design' window. 
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Union 

The 'Union' field allows combining the result of  two different 'SELECT', comparing 
data and deleting duplicated rows. 

This clause cannot be used to combine Subqueries. Both SELECT commands must 
have the same number of  output columns. Further, all columns must have the same 
data dimension and the same corresponding column name. The 'ORDER BY' 
command can be set only after the last SELECT and will have a major impact on the 
result. The 'UNION' clause may be useful to simulate an outer join. 

The '...' button next to the text-box allows opening an existing query. 

2.6.2 Fields, Group By and Order By 

The tab-strip 'Fields, Group by and Order By' in the 'Query' window displays the list 
of  fields used to show the result. You can scroll the list using the scroll bar on the 
side. You can change the fields' order simply moving them up or down. Right click the 
button on the left side of  the field, keep the mouse pressed and drag the field in the 
desired position. The fields order influences the result's layout. You can manage up to 
256 fields. 

 

Description 

The 'Description' column contains the fields' description. The descriptions are those 
defined during the 'Design' phase. 
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Name 

The 'Name' column contains the fields' name. These name are the ones defined during 
the 'Design' phase as alias of  the corresponding file. 

N.B. 

 You can add an expression, which is congruent with the kind of  field. 

Alias 

The 'Alias' column contains alias names of  fields, which will be used for the query 
result. It defaults the fields names defined during the 'Design' phase. You can change 
these names to better identify the fields (maximum 10 characters; no blanks allowed). 

Distinct Flag 

When this flag is set it excludes rows duplications from the query result. This flag 
equals the 'Distinct' clause of  SQL-SELECT. 

Order By 

The 'Order By' area contains the list of  fields that form the 'Order By' clause. Drag 
the fields from the list of  selected fields on the left to the 'Order By' area. You can 
change the fields' order simply moving them up or down. Right click the button on 
the left side of  the field, keep the mouse pressed and drag the field in the desired 
position. The fields order influences the query result. The query result can be ordered 
basing on one or more columns. By default values are in ascendent order. Double 
clicking the desired field in the 'Order By' area, values are displayed in descendent 
order. 
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Exercise 

You now  need  to  c rea te  a  query  to  ex t rac t  ' I tem No. '  and  ' P r i ce '  f rom the  
' I tems '  tab le .  The ' P r i ce '  w i l l  be  d i sp l ayed  i n  a s cenden t  o rde r  and  the  
' I tem No. '  i n  descendent  o rde r .  D rag  in  the  'O rder  By '  a rea  ' P r i ce '  f i r s t  
and  ' I tem No. '  a f te rwards .  Doub le  c l i ck  ' I t em No. '  t o  change the  o rder  i n  
des cendent .  

 

Group By 

The 'Group By' area contains the list of  fields that form the 'Group By' clause. You 
can change the fields' order simply moving them up or down. Right click the button 
on the left side of  the field, keep the mouse pressed and drag the field to the desired 
position. The fields order influences the query result. The query result can be grouped 
basing on one or more columns. 

Exercise 

You need  to  c rea te  a  query  to  ex t ra c t  ' I tem No. '  and  ' P r i ce '  f rom the  
' I nvo i ce '  t ab l e .  The query  resu l t  mus t  be  g rouped  by  ' I tem No . '  and  
'P r i c e ' .  D rag  in  the  'G roup  By '  a rea  'P r i c e '  f i r s t  and  ' I tem No. '  
a f te rwards .  To  g roup  the  que ry  re su l t  b y  ' P r i ce '  f i r s t ,  s imp l y  move  the  
'P r i c e  f i e l d '  a t  the  top  o f  the  'Group By '  a rea .  

 

Delete Field 

The 'Delete Field' button deletes the selected field from the 'Fields, Group By or 
Order By' area. 

Delete Group 

The 'Delete Group' button deletes the selected field from the 'Group By' area. 
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Delete Order 

The 'Delete Order' button deletes the selected field from the 'Order By' area. 

Pivot 

Clicking the 'Pivot' button a new dialog window is opened, in which you can define a 
Pivot on the Visual Query result. 

 

In the 'Pivot Fields' area add the fields required for the Pivot. The horizontal 
overturning will be executed on the last field of  the list. The field sequence is 
therefore important. The flags next to the 'Pivot Fields' area allow you to define the 
Pivot scale. 

The 'Values' flag considers single values of  the last field in the 'Pivot Fields' list; a 
column is created for each value. 

The 'Index' flag creates a list of  indexed values, starting from 1 and basing on the last 
pivoting field. 

The 'Month' and 'Day' flags create respectively 12 and 31 columns. Pivoting field 
values having daily or monthly information feed these columns. 
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The 'List' flag combined with the 'List/Query' area allows defining a list of  values that 
will form the column headers. Defining a list of  allowable fields in the 'List/Query' 
area, columns are created according to this latter list. 

The 'Data Fields' area contains the fields that are displayed in the Pivot result. Each 
column will be named according to the field alias name plus the extention '_XXX' 
detailing the column number. 

The 'Delete Pivot' and the 'Delete Data' buttons delete the selected field from the 
'Pivot' or 'Data Fields' areas. 

2.6.3 Join 

The 'Join' tab-strip within the 'Query' window detail the Join Relationships that form 
the 'From' clause in the SQL sentence. You can change the order of  the Join 
Relationships simply moving them up or down. Right click the button on the left side 
of  the row, keep the mouse pressed and move the relation to the desired position. The 
Join Relationships order influences the execution sequence within the 'From' clause. If  
no link exists between the two selected tables, you can add it manually. Click the 'Add' 
button and digit the name of  the tables, their fields and their values in the columns. 

 

N.B. 

The Join execution order is fundamental to query response times. 

Description 

The 'Description' column shows the relationship name and in brackets the name of  
the description of  the linked fields. 
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Expression 

The 'Expression' column shows the Join expression of  the fields defined in the  
columns 'Table1' and 'Table2'. 

N.B. 

In the 'Expression' area you can add an expression, which is congruent with the kind of  field. 
For the use of  the various SQL functionalities please refer to 'SQL functionalities'. 

Type 

The 'Type' column shows the kind of  Join used to link the tables defined in the 
columns 'Table1' and 'Table2'. There are four types of  Join: 'Left Outer', 'Right Outer', 
'Full' and 'Inner'. 

LEFT OUTER JOIN 

When the 'Left Outer' Join is used the query result displays all rows of  'Table1' on the 
left and on the right only the rows of  'Table2' fulfilling the Join condition defined in 
the 'Expression' column. 

RIGHT OUTER JOIN 

When the 'Right Outer' Join is used the query result displays all rows of  'Table2' on 
the right and on the left only the rows of  'Table1' fulfilling the Join condition defined 
in the 'Expression' column. 

INNER JOIN 

When the 'Inner Join' is used the query result displays only those rows fulfilling the 
Join condition defined in the 'Expression' column. 

FULL JOIN 

When the 'Full' Join is used the query result displays all rows of  both tables no matter 
if  they fulfill the Join condition defined in the 'Expression' column or not. 

WHERE 

Using 'Where' you can add a Join condition defined in the 'Expression' column in the 
WHERE clause of  the SQL sentence. 
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Table1 

The 'Table1' column shows the name of  the first selected table, from which data is 
read. Clicking the combo-box the list of  tables that can be used in the Join 
relationship is displayed. 

Table2 

The 'Table2' column shows the name of  the second table, in which read data is stored. 
Clicking the combo-box the list of  tables that can be used in the Join relationship is 
displayed. 

N.B. 

The creation of  the query always bases on the Data Dictionary created during the 'Design' phase. 
No matter the order in which tables are selected, the tool will always recognize the read and the 
receiving one. 

Delete 

The 'Delete' button deletes the selected Join relationship. 

Add 

The 'Add' button adds a blank row in which a further Join condition can be defined 

2.6.4 Filter 

The tab-strip 'Filter' in the 'Query' window shows filter parameters. Expressions 
created in this area will be part of  the 'Where' clause in the SQL sentence. Fields are 
selected by dragging them from the 'Design' window to the 'Filter' tab-strip of  the 
'Query' window. Filter variables must be added in the 'Filter Parameters' tab-strip. 
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You can change the expression order simply moving them up or down. Right click the 
button on the left side of  the row, keep the mouse pressed and move the expression 
to the desired position. The expression order influences the checking sequence within 
the 'Where' clause. 

N.B. 

The expression order is fundamental to the logic applied for validation. It must consider that 
'AND' conditions always come before 'OR' conditions. 

Field Name 

The 'Field Name' column contains the name of  the field used as filter. 

N.B. 

In the 'Expression' area you can add an expression, which is congruent with the kind of  field. 
For the use of  the various SQL functionalities please refer to 'SQL functionalities'. 

Not 

The 'Not' column inverts the condition defined in 'Criteria'. 

Criteria 

In the 'Criteria' column you can specify the operator that must be used to compare the 
'Field Name' and the 'Example' columns. 
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Operator Meaning 

= Equals 

Like SQL LIKE 

> Greater Than 

> = More Than or Equal To 

< Less Than 

< = Less Than or Equal To 

< > Different From 

in Included 

not in Not Included 

exists Exists 

not exists Does Not Exist 

between Between (Two) 

not between Not Between (Two) 

is null Equals null 

is not null It is not null 

> all More Than All 

> any More Than Some 

< all Less Than All 

< any Less Than Some 

> = all More Than or Equal To All 

> = any More Than or Equal To Some 

< = all Less or Equal To All 

< = any Less or Equal To Some 

< > all Different From All 

< > any Different From Some 
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Example 

The 'Example' column contains values that must be compared with the 'Field Name' 
column. The value can be constant, or taken from a Routine, or from the 'Filter 
Parameters' tab-strip having the prefix '?', or clicking the '...' button you can define a 
Sub-Query that outputs a logical value according to the defined logical operator ('in', 
'exists', 'between', 'is null', 'all', 'any', etc.). 

The 'Example' area will be activated only if  at least one parameter has been defined in 
the 'File Parameters' tab-strip. 

Exercise 

I n  the  ' F i l t e r  Pa rameter s '  t ab - s t r i p  de f ine  the  pa rame ter  ' COD_IN I '  as  
s e le c t ion  s ta r t i ng  code .  Go to  the  ' F i l t e r '  tab-s t r i p  and  d ig i t  ' COD_IN I '  in  
the  'Example '  co lumn .  I f  you  check  the  SQL sentence  you can  not i ce  tha t  
the  f i l t e r  expres s ion  i n  the  'WHERE '  c lause  i s :  

SELECT .....

FROM .....

WHERE <FieldName> = COD_INI and ....

GROUP BY ....

ORDER BY ....

INTO CURSOR __TMP__

Go back  to  the  'Examp le '  c o l umn and add  the  p re f i x  ' ? '  in  f ron t  o f  
' COD_IN I ' .  I f  you check  the  SQL sentence  you can no t i c e  t ha t  t he  f i l t e r  
expres s ion  i n  the  WHERE c lause  has  now  changed:  

SELECT .....

FROM .....
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WHERE <FildName> = <Take On Value from COD_INI> and ....

GROUP BY ....

ORDER BY ....

INTO CURSOR __TMP__

In  the  WHERE c lause  ' COD_IN I '  has  been rep l aced  by  t he  ' Taken  On  
Va lue ' .  

 

Logical 

The 'Logical' column contains the logical value of  filter expressions. You can select 
one of  the two following options: 

Value Meaning 

AND Logical connection between expressions 

OR Distinguishes the logic between the expressions 

 

N.B. 

'AND' logically binds expressions whereas using 'OR' you obtain logically separate expressions. 

Having 

The 'HAVING' flag is used for aggregation functions. It specifies filter condition s 
that groups of  data must have in order to be included in the query result. The 
'HAVING' clause must be used together with the 'GROUP BY' clause. 

Delete Filter 

The 'Delete Filter' button deletes the selected filter expression. Removing the filter 
expression does not delete the parameters used in the expression. 
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Add Filter 

The 'Add Filter' button adds a blank row to the filter. 

2.6.5 Filter Parameters 

The 'Filter Parameters' tab-strip in the 'Query' window contains filter parameters. 
Filter parameters must be created basing on fields that have been selected for the 
query. 

 

To select fields drag them from the 'Design' window  and drop them into the 'Filter 
Parameters' tab-strip of  the 'Query' window. Should the same parameters be selected 
twice (e.g. 'pCODART'), a repetition number will be added to the parameter (e.g. 
'pCODART1'). You can change the parameters order simply moving them up or 
down. Right click the button on the left side of  the row, keep the mouse pressed and 
move the parameters to the desired position. The parameters order influences the 
sequence of  how parameters will be called in the dialog window, indeed parameters 
will be called from the top to the bottom of  the list. 

Parameters defined in the 'Filter Parameters tab-strip will be used in the 'Example' 
column of  the 'Filter' tab-strip as part of  the WHERE clause. You can also add 
parameters manually clicking on the desired row and digiting the parameter. 

Field Name 

The 'Field Name' column contains the parameters name. Fields are selected by 
dragging them from the 'Design' window and dropping them into the 'Filter Name' 
column. Dragged fields are automatically changed into parameters taking on the prefix 
'p'. Parameters are used in the 'Example' column of  the 'Filter' tab-strip as part of  the 
WHERE clause. 
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N.B. 

In the 'Filter' tab-strip no expressions can be defined. 

Description 

The 'Description' column contains the parameters description. These descriptions are 
used in the dialog window. Descriptions defined during the 'Design' phase are 
defaulted, but can be changed. 

Type 

The 'Type' column contains the parameters type (characters, numeric, date, logic). The 
parameter type must be the same as the field type selected in the 'Field Name' column 
in the 'Filter' tab-strip. 

Len 

The 'Len' column contains the parameters lengths. 

Dec 

The 'Dec' column contains the decimal number of  parameters. 

Delete Param. 

The 'Delete Param.' button deletes selected filter parameters. Deleting a parameter 
does not affect the 'Example' column in the 'Filter' tab-strip. 

Dialog 

The 'Dialog' field contains the name of  the dialog window that is associated to the 
query. Clicking the '...' button the 'Open' the list of  dialog widows is displayed, i.e. files 
with the extention .VFM. 
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Remove Filter On Empty Parameter 

The 'Remove Filter On Empty Parameter' flag allows excluding selected parameters, 
when no value is defined. When the flag is activated and the query is run all conditions 
relating to blank parameters are excluded from the WHERE clause. 

Exercise 

Crea te  a  que ry  hav ing  a  d ia log  w indow tha t  a l l ows  i nput t i ng  two 
pa ramete r s ,  e . g .  f rom 'Code '  to  ' Code ' .  I f  you  con f i rm the  d ia log  w indow 
w i thout  hav ing  de f i ned  pa ramete r s  the  WHERE  c l ause  i s  e xc luded f rom 
the  SQL sen tence .  I f  you  de f i ne  on l y  one  o f  the  two pa rame ter s ,  the  
WHERE c lause  w i l l  have  on ly  the  cond i t ion  fo r  the  de f ined  pa rame ter  
( and  noth ing  concern ing  the  b lank  paramete r ) .  

 

Generate Code 

The 'Generate Code' button allows generating the file required for the Static Query. 
Static Queries can be used in routines and cannot be changed by the user. Selecting 
this option a static copy of  the query is created, changing the file extention from 
.VQR to .INC. During generation the .INC file is included in the routine. The static 
copy can be changed by the user only reselecting this option and codifying the routine 
to which it is linked. 

2.6.6 Note 

The 'Note' tab-strip in the 'Query' window contains dedicated areas and comments on 
the query. You can add description strings to explain query functionalities, to detail 
related reports, MS Word documents, etc. 
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2.7 SQL Functionality 

CodePainter makes a set of  SQL functionalities available, which can be used in the 
areas where fields or fields and variables are compared. The most typical example is 
the 'Join Expression' area where join conditions between tables are defined. The 
'Filter/Field Name' area is another example, where comparison fields for data 
extraction are defined. 

 

SQL functionalities must be digited according to the following
syntax:'['<FunctionName>'('<Param>{','<Param>}')' ']'

Function names are not case sensitive. Functions cannot be nested. Allowed functions 
are detailed in the following tables: 
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2.7.1 Conversion Functions 

VAL(cExp) Returns the cEXP numeric value as float 

STR(nExp) Converts nExp in string 

DATE(cExp) Converts cExp in a constant data; cExp must be a string between 
apexes: cExp = '(D)D-(M)M-(YY)YY'. Values in brackets are optional. 
Minus signes (-) are both compulsary and cannot be replaced by other 
symbols (eg. '/' or '.'). 

 

2.7.2 String Functions 

LTRIM(cExp) Deletes blanks in front of  cEXP 

RTRIM(cExp) Deletes blanks after cExp 

TRIM(cExp) Deletes blanks in front of  and after cExp 

SUBSTR(cExp, nS [, nL]) Extract from cExp nL characters starting from nS; if  nL is 
omitted all characters are extracted strating from nS to the 
end of  cExp. 

 

2.7.3 Date Functions 

YEAR(dExp) Returns the numeric value of  the year expressed in dExp. 

MONTH(dExp) Returns the numeric valie of  the month expressed in dExp. 

DAY(dExp) Returns the numeric value of  the day expressed in dExp. 

 

2.7.4 Other Functions 
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NVL(Exp1,Exp2) Returns the first argument, which is not NULL (from left to 
right); only two arguments are admitted 

 

2.8 Using the Query Painter 

The 'Query Painter' is fully integrated with the Data Dictionary and allows creating 
queries easily and quickly. The list of  tables and their relationships are readily 
accessible. 

 

To select tables double click the desidered one in the 'Table' area of  the 'Dictionary' 
window. You can also drag&drop it in the 'Design' window or in the 'Tables' tab-strip 
of  the 'Query' window. 
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If  you drag&drop the 'Items' table in the 'Design' window you can notice that an 
object with the same name appears in the 'Table' tab-strip in the 'Query' window. This 
object takes on the table's alias and its physiscal name. If  the selected table is linked to 
one or more tables, the 'Relationships' window is opened detailing realtionships, linked 
fields and type of  Join. If  you click on one relationship in the last column the 
description 'Exclude' appears on the right. This means that the table will be added to 
the query as Natural Join. 

Add the 'VAT Rates' table in the 'Design' window. Again the 'Tables' tab-strip in the 
'Query' window is filled in. If  you want to delete a selected table, go to the 'Tables' 
tab-strip in the 'Query' window, select the desidered table and click the 'Delete' button. 
The table is deleted also from the 'Design' window. Similarly you can delete fields and 
joins. 

N.B. 

Deleting a Join deletes the Join but not the involved tables. 

 

Fields for queries are selected double clicking the desidered one in the 'Fields' area of  
the 'Dictionary' window or by drag&drop. Selected fields are automatically displayed 
in the 'Design' window as well as in the 'Fields, Group By or Order By' tab-strip of  
the 'Query' window. 
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From the 'Items' table select the fields 'Item No.', 'Description' and 'VAT Rates'. From 
the 'VAT Rates' table select 'VAT Code' and 'Description'. Clilck the 'SQL Sentence' 
button on the toolbar. With only a few clicks you have just written the following SQL 
sentence: 

 

You now need to define filter parameters for the query. Filter paramenters are defined 
basing on fields selected for the query. Go to the 'Filter Parameters' tab-strip in the 
'Query' window. Adding parameters in this area involves the automatic generation of  a 
dialog window for inputting parameters and filter expressions. Go to the 'Fields of' 
area in the 'Tables' window and drag&drop the desired fields in the 'Field Parameters' 
tabstrip of  the 'Query' window. 
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To define a 'from - to' selection, the same field in selected twice (as shown in the 
picture above). You now need to distinguish the field that will contain the starting 
parameter, from the field that will contain the final parameter. In the 'Field Name' 
column change the defaulted names ('pARCODART' and 'pARCODART1') into 
'pFROM_ARCODART' and 'pTO_ARCODART'. Following the same principle 
change the descriptions. 

 

Now go to the 'Filter' tab-strip. Values have been automatically defaulted. Notice the 
prefix '?' in the 'Example' column. In the 'Criteria' column select '>=' in the first row 
and '<=' in the second row. The filter definition is completed. 

 

Variables and strings defined in the 'Filter Parameters' tab-strip are used to 
automatically create the selection dialog window that is opend when you click the 
'Execute Query' button in the toolbar. 
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Enter parameters in the 'Selection parameters' window (e.g. Item02 and Item05). Your 
query result should look like the one shown in the following picture. 

 

You can create reports that involve more files basing on the same SQL Sentence 
structure. To change the report click the 'Create/Modify Report' button. The report 
prototype is opened. 
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This button executes the report in the defined source language. Using this button you 
can create a new report and save it with the extention .FRT or open an existing one. 

2.9 The Tool's Composition 

The Query Painter has the following routines. 
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Program Function 

VQ_BUILD.PRG To paint the query. 

VQ_EXEC.PRG To execute the query. 

VQ_LIB.PRG Class libraries for the tool. 

VE_BUILD.PRG To interface the tool with MS Excel. 

VG_BUILD.PRG To interface the tool with MS Graph. 

VG_EXEC.PRG To execute and manage graphs 

 

The VQ_BUILD.PRG procedure allows painting and building the query. The created 
file is saved in .VQR format, the same extention used by the query structure. The 
procedure is automatically integrated in the application's 'Utility' menu under the 
option 'Query Painter'. The query can be executed directly from the tool ('Execute 
Query' button) or in interactive mode launching the procedure VQ_EXEC. This latter 
way requires to write the query name between apexes. The VQ_EXEC can also be 
executed from CP_LIB, which depending on the file extention executes the correct 
translator. 

N.B. 

If  the query name is left empty the 'Open' dialog window is opened and you can select the desidered 
query. 

The VE_BUILD.PRG routine allows interacting with MS Excel passing on extracted 
values to a MS Excel worksheet. 

The VG_BUILD.PRG and the VG_EXEC.PRG manage graphs created in MS 
Graph. Graphs are executed with the VG_EXEC routine and has the following 
syntax: 

VG_EXEC ;<GraphModelName.VGR> ,<SPACE> <calling object
pointer>,<SPACE> <QueryName.VQR>

N.B. 

If  the graph model name is left empty a new graph will be opened using the MS Graph default 
graph. 
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Exercise 

do vq_exec with ='prova'

Executes  the  query  'p r ova ' .  

do vq_exec

Opens  the  'Open '  d i a l og  w indow  in  wh ich  the  des i de red  query  ( ex tent ion  
.VQR)  can  be  se l ec ted .  

VX_EXEC with "<QueryName>".VQR

Execut i ng  the  query  f rom the  menu,  the  t rans l a to r  i s  l aunched ,  wh i ch  
executes  the  <QueryName> bas ing  on  the  f i l e  ex tent i on  .VQR.  

 

N.B. 

If  a report is associated to the query the Print Manager is launched. If  you want the query 
preview, you need to add the 'PREVIEW' parameter in the procedure: 

VX_EXEC with "<QueryName>".VQRPREVIEW

N.B. 

If  more than one report is associated to the query you need to define which report must be printed 
when the query is executed. You therefore need to digit the report name and its extention next to 
the query name: 

VX_EXECwith"<QueryName>.VQR,<ReportName>"

The preview option can also be attached. 
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2.10 Integrating A Query In An 
Application 

Created queries can be integrated in any CodePainter entity, no matter if  it is 
interpreted or compiled. This means that queries can be called from within Master 
Files, Detail Files, Mater/Detail Files, interpreted or compiled Dialog Windows, etc. 

Queries can be used within the 'Select' instruction of  a Routine in order to obtain a 
cursor for specific data processing; or a query result can be used to produce a MS 
Word and/or MS Excel report or mailmerge; or a query can be associated to a Visual 
Zoom in order to have powerful multifile zooms. Let us now see some examples. 

2.11 Multifile Query And Visual 
Autozoom 

You are now required to use the 'Query Painter' to define a SQL sentence that extracts 
all items, its descriptions, and prices with and without VAT. 

Open a new query, select the 'Items' table and the fields 'Item No.', 'Description', 
'VAT Code'. Select the 'VAT Rates' table and the fields 'VAT Code' and 'Decription'. 
Running the query you should obtain the following result: 
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Save the query as QBE_ART. Exit the 'Query Painter', open the 'Items' menu and 
select 'List' to associate the query to the zoom. Click the 'Options' button and go to 
the SQL tab-strip. Click the 'Query File' button. In the 'Open' dialog window select 
the created query (QBE_ART.VQR). 
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Click 'OK' to confirm. The query is executed and the zoom displayes only those fields 
you selected for the query. You can now change and integrate other Visual Zoom 
options. Once you have customized the zoom you need to save it. Go to the 'Field' 
tab-strip, activate  the 'Default' flag and save. You have just created the following 
configuration file: 

<ConfigurationName>.<FileName>_VZM

where <ConfigurationName> is the name you used to save the custom configuration 
('default') and <FileName> is the name of  the table used. If  you click the 'Settings' 
button you will find a file named 'Default.Items_VZM'. 
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If  you go back to the 'Items' 'List' you can notice that items are displayed basing on 
the associated query. 

N.B. 

You can create a dedicated subdirectory named 'Default' under which you save default queries. 
During the 'Design' Phase the system will always search for .VQR files under this directory. 
Before launching a query from a procedure you have to define the correct path. For example, if  you 
launch the query named 'prova' saved under the subdirectory 'Default', you need to define the path 
'Default\prova.VQR'. 
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2.12 Multifile Query And 
Reporting 

In this section we will see how the 'Query Painter' can be used to create a report of  
customers having an e-mail address. Further we will create a letter to be sent via e-
mail. First of  all you are required to create a dialog window containing the required 
selection variables, and two buttons to print or exit the window. The 'Print' button will 
launch the extraction query to which the customers' list report is associated. Further 
you will associate an MS Word model that executes the mailmerge to send the e-mails. 

2.12.1 Selection Dialog Window 

Go to CodePainter Front End, add a new Dialog Window entity in your design plan 
and generate the Design. Open the 'Painter' menu, select 'Dialog Window Painter' and 
open the added dialog window. Define the following selection dialog window: 
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Add four variables: two for entering the 'from' and 'to' customer key (sCLCODCLI 
and eCLCODCLI) and two to display the corresponding company name 
(sCLRAGCLI and eCLRAGCLI).  
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These variables are linked to the 'Customers' table and are passed on to the query for 
data extraction. Add the strings 'From customer:' and 'To customer:'. 

Add two buttons: one to print and one to exit the dialog window. The 'Exit' button 
uses the 'Quit' System Function. The 'Print' button uses the 'User Tool Kit' option. In 
the 'Execute' field digit the query name QBE_CLI.VQR that you are about to create. 
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Complete the dialog window adding the title and the table that must be used. Save the 
dialog window exit the 'Dialog Window Painter' and re-generate your application. Run 
the application and you will find a new menu item, e.g. 'Customer Report' 

2.12.2 Creating The Query 

Open the 'Utility' menu and select the 'Query Painter'. Select the 'Customers' file and 
drag the following fields in the 'Field, Group By and Order By' tab-strip: 'Customer 
key', 'Company Name', 'Address', and 'E-mail Address'. 
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Drag the 'Customer Key' field to the 'Filter Parameters' tab-strip. In the 'Field Name' 
column write the first variable defined in the Selection Dialog Window, namely 
'w_sCLCODCLI'. Do the same for the second variable 'w_eCLCODCLI'. These 
parameters are also defaulted in the 'Example' column in the 'Filter' tab-strip. 

 

To select only customers having an e-mail address, click the 'Add Filter' button in the 
'Filter Parameters' tab-strip. In the 'Field Name' column digit 
'Empty(cli_enti.CLEMAIL), set the 'NOT' flag, in the 'Criteria' column select the '=' 
operator, and in the 'Example' column digit '.t.'. 

 

Save the query as 'QBE_CLI.VQR' and test it. 
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2.12.3 Create/Modify Report 

You can now modify the customers list. Click the 'Create/Modify Report' button on 
the 'Query Painter' toolbar. The report prototype is opened. Using MS Visual FoxPro 
report tool functionalites change the report until it looks similar to the following 
picture: 

 

Check your report using the 'Preview' functionality (right clcik the mouse), save and 
close it. 

2.12.4 Creating The MS Word Model 

Click the 'Create/Modify Mailmerge button' on the 'Query Painter' toolbar. The 
.DOC model having the same name as the query is opened (QBE_CLI.DOC). Write a 
letter and integrate database fields selecting them from the 'Insert Merge Field' 
combobox. 



V I S U A L  T O O L  G U I D E

Q U E R Y  P A I N T E R  6 1  

 

Format the document as to obtain the desidered letter layout. 

 

 To check the model open the MS Word 'Tools' menu and select 'Mail Merge'. 
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The 'Mail Merge Helper' has different options. 

The first concerns the main document, i.e. the created model, and the kind of  merge 
that must be done (please refer to MS Word manuals for more information). 

In the second option the source of  data is selected. In this exercise data is stored in 
the _WORD_.DBF file under the temporary Windows directory 
(C:\WINDOWS\TEMP). 

From the third option the mail merge of  data with the model is launched (please refer 
to MS Word manuals for more information).  

In the first option click the 'Create' button and select 'From Letters...'. 
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A message asks you if  you want to change the document or create a new main 
document. Click on the 'Change Document Type' button. 

 

In the third option click the 'Merge' button. The 'Merge' dialog window is opened. In 
the 'Merge to' select 'Electronic Mail'. You are merging the document to MS Outlook.  
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Click the 'Setup' button to open the 'Merge to Setup' window. Click the combobox 
under the 'Data Field with Mail/Fax address' to select the field in which customers e-
mail addresses are defined ('clemail'). You can also add an e-mail heading and decide 
to send the document as attachment. 

 

Confirm with 'OK' to go back to the 'Merge' window and click the 'Merge' button to 
confirm. After a few seconds you can check in your Mail Outbox that e-mail messages 
are sent to all customers selected by the query. Save the created Word model and close 
the Query Painter. 

2.12.5 An Example 

Open the 'Customer Report' menu you created at the beginning of  this chapter. The 
'Customer Report' window is opened. Fill in the window and click 'Print'. 
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The 'Print System' window is opened. 

 

Click the 'Print Preview' icon on the bottom left of  the window to view the result on 
the screen. Click the 'Microsoft Word Document' button to merge the data and 
produce the QBE_CLI.DOC document. Simply clicking the 'Merge' button on the 
'Mail Merge' toolbar e-mails will be automatically sent. 

 

Clicking the 'MS Excel Document' you can extract data into an Excel worksheet. The 
first row contains the field names. 
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2.13 Multifile Queries With 
Interpreted Selection Dialog 
Windows 

You are now required to extract 'Items' that fall under a given range. Create a query to 
extract 'Item No.', 'Description', and 'VAT Rate' from the 'Items' file and 'VAT Rate' 
and 'Description' from the 'VAT Rate' file. To associate a filter and a selection dialog 
window to the query, add the 'Item No.' field twice in the 'Filter Parameters' tab-strip 
of  the 'Query' window. Change the field names into 'pARCODART_i' and 
'pARCODART_f'. Go to the 'Filter' tab-strip and define the criteria for the filter 
expression. 



V I S U A L  T O O L  G U I D E

Q U E R Y  P A I N T E R  6 7  

 

Execute the query to check that it works. The selection dialog window has been 
automatically created by the tool. You are required to associate a filter and the 
corresponding interpreted dialog window to the query. Association are made simply 
clicking the '...' button next to 'Dialog' in the 'Filter Parameter' tab-strip and selecting 
the desired dialog window. You still need to create the Dialog Window that must be 
associated. Save the query as 'QBE_AR1'. Exit the 'Query Painter' tool, open the 
'Utility' menu and select 'Dialog Window Painter'. 

Click the 'Opt.' button on the 'Dialog Window Painter' toolbar to define the window's 
title, namely 'Item Selection'. Confirm with 'OK'. Add the 'starting item' clicking the 
'Variable' button. Double click the added variable. In the 'Variable Options' window 
digit the variable's name (pARCODART_i) and activate the 'Fill With Zeros' flag. 

N.B. 

The variable name must be same as the one defined in the 'Example' column of  the 'Filter' tab-
strip in the'Query' window ('Query Painter'). 

Click the '...' button next to 'Archives' and select 'Items', i.e. the file from which data 
must be read. The 'Items' primary key is defaulted in the 'Fixed Key' area. In the two 
fields under the heading 'Linked Field' digit 'ARDESART' and 'xARDESART'. 
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Add another variable for the 'Item Description'. Define the variable name as 
'xARDESART' and deactivate the 'Editable' flag, so that the variable is display only. 
Following the same steps create the 'To Item' fields, adding a variable named 
'pARDESART_f' and a second variable named 'xARDESART1' as display only. Add 
two strings 'From Item Code' and 'To Item Code'. 
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Save the dialog window as 'DGW_AR1' and go back to the 'Query Painter'. Open the 
'QBE_AR1' query, go to the 'Filter Parameters' tab-strip in the 'Query Window' and 
click the '...' button next to 'Dialog'. Select the 'DWG_AR1.VFM' file and save. 
Running the query you can notice that the query displays the created Dialog Window. 
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2.14 Query And Routine 

Within 'Routine' procedures you can integrate 'painted' queries in the 'Select From' 
instruction. 
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Go to CoodePainter Front End and open the 'Routine Painter'. Add a 'Select' 
command to your routine. The 'Select From' window is opened. Select the 'Standard 
Query' flag and click the '?' button next to 'Field Name'. The 'Queries' window is 
opened detailing all available queries. Select the desidered query and confirm with 
'OK'. This allows you obtaining complex data extractions. During the routine 
execution the query result is a cursor (temporary support file) that can be used by the 
instruction to perform defined actions. You can so make complex routines that are 
easy to use and to maintain. 

To obtain 'Static Queries' you need to start from the query and click the 'Generate 
Code' button. Its use is basically the same as 'Standard Queries' with the difference 
that during the Codify Phase they are codified within 'Routines'. 'Static Queries' can be 
changed only by changing the query and re-generating the code for the Routine entity. 
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2.15 Limited Access To The Query 
Painter 

To limit or deny access to the Query Painter open 'Utility' menu and select 'Procedure 
Security'  when the 'Query Painter is opened in the background. For further 
information please refer to the 'Programming and Utilities Guide'. 
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Chapter 3  

Dialog Window 
Painter 

3.1 Introduction 

The Dialog Window Painter deeply exploits Object-Oriented Programming, 
integrating the Query Painter and allowing to create interpreted dialog windows, i.e 
selection windows that are not hard coded. 

3.2 The tool 

Run your application open the 'Utility' menu and select the 'Dialog Window Painter'. 
An empty dialog window and a dedicated toolbar are opened. 
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3.3 The Dialog Window Painter 
Toolbar 

The 'Dialog Window Painter' Toolbar has a set of  buttons that help you interacting 
with the tool: 
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Button Name Action 

 
New Opens a new Dialog Window (.VFM). 

 
Open Opens an existing Dialog Window (.VFM). 

 
Save Saves the opened Dialog Window. 

 
Save As Saves the opened Dialog Window with a 

different file name. 

 
Exit Exits the Dialog Window Painter and goes 

back to the application. 

 
Dialog Window Options Opens the Options Dialog Window. 

 
String To add strings. 

 
Variable To add variables. 

 
ComboBox To add comboboxes. 

 
CheckBox To add checkboxes. 

 
Button To add buttons. 

 
Bitmap Image To add bitmaps from which procedures can 

be executed. 

 
Cut To cut selected elements. 

 
Copy Selected elements are saved in a memory 

buffer. 

 
Paste Elements saved in the buffer are pasted. 

 
Align Left Selected elements are aligned to the left. 

 
Align Right Selected elemets are align to the right. 

 
Align Top Selected elements are aligned at the top. 
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Align Bottom Selected elements are aligned at the bottom. 

 
Same Horizontal Distance Selected elements are rearranged leaving the 

same horizontal distance. 

 
Same Vertical Distance Selected elements are rearranged leaving the 

same vertical distance 

 

3.3.1 New 

The 'New' button clears the memory and opens a new Dialog Window. 

3.3.2 Open 

The 'Open' button opens an existing dialog window. 

3.3.3 Save 

The 'Save' button saves the current dialog window. 

3.3.4 Save As 

The 'Save As' button saves the current dialog window with a different name. 



V I S U A L  T O O L  G U I D E

D I A L O G  W I N D O W  P A I N T E R  7 7  

3.3.5 Exit 

The 'Exit' button exits the Dialog Window Painter and goes back to the running 
application. 

3.3.6 Option 

The 'Opt.' button opens the 'Dialog Window Options'  window. 

Dialog Window Options 

In the 'Dialog Window Options' window you can define the dialow window's title, and 
set the 'Modal' and the 'Background' flags. 

 

Title 

In the 'Title' field you can define the Dialog Window's title. 

Modal Flag 

Activating the 'Modal' flag the windows becomes modal (for more information refer 
to the MS Windows Manuals). 

Background 

Activating the 'Background' flag allows defining the current Dialog Window as the 
standard application background. 
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3.3.7 String 

The 'String' button allows adding a string to the dialog window. Double clicking the 
added string the 'String Option' dialog window is opened. 

 

You can define the string text and the text alignment within the string cell (left, right 
or centred alignment). 

3.3.8 Variable 

The 'Variable' button allows adding a variable to the dialog window. Double clicking 
the added string the 'Variable Option' dialog window is opened. 

Variable Options 

In the 'Variable Options' window you can define the variable's options. 
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Variable 

In the 'Variable' field the field name must be entered. 

Type 

The field 'Type' can be selected from the combobox (Character, Numeric, Date). 

Lenght 
The field 'Length' is defined in the 'Len.' field. 

Decimals 

Field 'Decimals' can be defined in the 'Dec.' field for numeric fields only. 

Editable Flag 

The 'Editable Flag determines whether the field can be edited or not. Non editable 
fields are for example field descriptions. 

Fill With Zeros Flag 
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When the 'Fill With Zeros Flag' is selected and a value is entered in the variable, the 
value will be automatically filled with zeros (in front of  the entered value). This flag 
can be used only when the variable is a character type. The zero filling is not 
performed when the entered value starts with a letter or a zero. 

Exercise 

Def i ne  a  var i ab l e  a s  ' Cha rac te r '  and  l engh t  ' 10 '  and  se t  the  ' F i l l  W i th  
Ze ros '  f l ag .  

Enter  the  va lue  A12B.  The va lue  i s  no t  changed ,  because  the  va lue  s t a r t s  
w i th  a  l e t te r .  

Ent er  the  va lue  0112.  The  va lue  i s  not  changed ,  because  the  va lue  s ta r t s  
w i th  a  z e ro .  

Enter  the  va lue  1462.  The  va lue  i s  changed  to  0000001462 .  

Enter  the  va lue  1TE22 .  The  va lue  i s  changed  to  000001TE22.  
 

Picture 

In the 'Picture' field you can define a picture for the variable. 

Archives 

Clciking the '...' button next to 'Archive' you can browse and select the database table 
to which the database table must be linked. 
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Fixed Key 

The three empty fields in the 'Fixed Key' area are the fixed part of  the key linking the 
variable to a database table having a composite key. The fourth field must contain the 
name of  the last field composing the key. This latter field is automatically filled when 
the database table is selected. 

Values 

The three empty fields in the 'Values' area are the values of  the fixed part of  the key 
linking the variable to a database table having a composite key. The fields are empty if  
the table primary key is not composite. 

Linked Field 

In the 'Linked Field' you can define the name of  the field you want to download from 
the link. Next to this field the name of  the variable containing the retrieved value 
must be defined. 

3.3.9 ComboBox 

The 'ComboBox' button allows adding a combobox to the dialog window. Double 
clicking the added combobox the 'ComboBox Options' window is opened. 
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ComboBox Options 

In the 'ComboBox Options' window you can define the combobox options. 

 

Variable 

In the 'Variable' field the combobox name must be entered. 

Type 

The field 'Type' can be selected from the combobox (Character, Numeric, Date). 

Lenght 
The combobox 'Lenght' is defined in the 'Len.' field. 

Decimals 
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Combobox 'Decimals' can be defined in the 'Dec.' field for numeric fields only. 

Editable Flag 

The 'Editable Flag' determines whether the combobox must be edited or not. 

Values 

In the 'Values' column you can define up to 10 combobox values. 

Descriptions 

In the 'Description' column you can define the combobox value descriptions. 

3.3.10 CheckBox 

The 'CheckBox' button allows adding a checkbox to the dialog window. Double 
clicking the added checkbox the 'CheckBox Options' window is opened. 

CheckBox Options 

In the 'CheckBox Options' window you can define the checkbox options. 

 

Variable 
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In the 'Variable' field the checkbox name must be entered. 

Type 

The field 'Type' can be selected from the combobox (Character, Numeric, Date). 

Lenght 
The checkbox 'Lenght' is defined in the 'Leng.' field. 

Decimals 

Checkbox 'Decimals' can be defined in the 'Dec.' field for numeric fields only . 

Editable Flag 

The 'Editable Flag' determines whether the checkbox must be edited or not. 

Title 

The title defined in the 'Title' field is displayed next to the checkbox. 

Checked Value 

In the 'Checked Value' field you can define the value that the variable must contain 
when the checkbox is checked. 

Unchecked Value 

In the 'Unchecked Value' field you can write the value that the variable must contain 
when the checkbox is unchecked. 

3.3.11 Button/ Bitmap Image 

The 'Button' and the 'Bitmap Image' buttons allow adding a button/ bitmap image to 
the dialog window. Double clicking the added object the 'Button/ Bitmap Image 
Options' window is opened. 

Button/ Bitmap Image Options 

In the 'Button/ Bitmap Image Options' window you can define the button options. 
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Execute 

In the 'Execute' field you need to define the name of  the program you want to execute 
when the button/ bitmap image is clicked. 

Type 

The 'Type' of  object you want to execute is selected from the combobox. You can 
select Program, Dialog Window, Query/Report, and Zoom. 

Title 

The button/bitmap image description is defined in the 'Title' field. 

Bitmap 

Clicking the '...' button next to the 'Bitmap' field you can select a bitmap image for the 
button. 

Invisible 

Activating the 'Invisible' flag the button is not shown. Using this option you can create 
bitmap images that can run programs through invisible buttons. 

3.3.12 Cut 

The 'Cut' button cuts selected areas from the working window. You can retrieve the 
deleted objects clicking the Paste button. 
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3.3.13 Copy 

The 'Copy' button saves the selected area in a temporary memory buffer. To paste the 
copied area click the Paste button. 

3.3.14 Paste 

The 'Paste' button pastes the objects contained in the temporary memory buffer. 

3.4 Designing Dialog Windows 

Let us now analyze how Dialog Windows can be designed using the Dialog Window 
Painter. You are required to create a Dialog Window named 'Items Selection' that fills 
the filter parameters of  a given query. Click the "Opt." button on the toolbar, digit the 
title 'Items Selection' and click 'OK' to confirm. 

 

Click the variable button to add the 'From Item No.' variable. Double click the added 
variable and digit 'pARCODART_I' next to the 'Variable' field. Leave the variable 
'Type' as Character and activate the 'Fill With Zeros' flag. 

N.B. 

The variable name must be the same as the one defined in the query, i.e. the one defined in the 
'Filter Parameters' tab-strib. 
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Double click the '...' button next to 'Archives' and select the 'Items' table. The primary 
key field is defaulted in the 'Fixed Key' area. To display the item description digit 
'ARDESART'  and 'xARDESART' in the two fields under the 'Linked field' heading. 
Confirm with 'OK'. 

 

Add another variable for the 'Item Description', digit 'xARDESART' in the 'Variable' 
field and deselect the 'Editable' flag, because the item description must be display only. 
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Similarly, define the 'To Item No.' variables, namely 'pARCODART_f' and 
'xARDESART1'. Add two strings ('From Item No.' and 'To Item No.') next to the 
variables. Align all objects to obtain the result shown in the following picture: 
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Save the Dialog Window as "DLG_ITEM1". The Dialog Window is ready to be 
integrated in the query. 

3.5 Tool insight 

First of  all let us see how many routines build the Dialog Window Painter. 

Procedure Function 

VM_BUILD.PRG To design the dialog window. 

VM_EXEC.PRG To execute the dialog window. 

VM_LIB.PRG Class library for the tool. 

 

The VM_BUILD.PRG procedure allows drawing and building Dialog Windows. It 
creates .VFM files containing the dialog window structure. The created Dialog 
Window is automatically added to the 'Utility' menu. 

The VM_EXEC.PRG procedure has as defined parameter the dialog window name in 
apexes. A dialog window can be executed using this procedure directly from the menu 
or simply calling the 'VX_EXEC' procedure, which identifies the correct translator 
basing on the file extention. 

N.B. 
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If  the 'Execution' field is left empty a selection window is opened, from which .VFM files can be 
selected. 

Exercise 

wm_exec with 'prova'

Executes  the  ' p rova '  d i a l og  w indow .  

wm_exec

Opens  the  'Open '  w indow f rom wh i ch  the  d ia log  w indow i s  s e le c t ed  ( .VMF 
ex tent ion ) .  

VX_EXEC with '<WindowName>.VFM'

Bas ing  on  the  f i l e  ex tent ion  .VFM the  t rans l a t o r  execute s  t he  d ia log  
w indow '<WindowName>'  f rom the  menu .  

 

3.6 Integrating The Dialog Window 
In The Application 

Objects created with the Dialog Window Painter can be easily integrated in queries, 
routines or used to substitute/integrate the application's menu. Designed dialog 
windows can be executed from within any entity. Let us now see some examples. 

3.6.1 Dialog Windows and MultiFile Queries 

To integrate a dialog window in a query open the 'Query Painter' go to the 'Filter 
Parameters' tab-strip and digit the dialog window name in the 'Dialog' field. 



V I S U A L  T O O L  G U I D E

D I A L O G  W I N D O W  P A I N T E R  9 1  

 

When the dialog window is executed you can define selection parameters that will be 
used for extracting data. 

3.6.2 Dialog Windows and Routines 

To integrate dialog windows in routine entities you need to open CodePainter Front 
End and use the 'Exec' command in the Routine Painter. In the 'Exec Definition' 
window select 'UTK Object' from the combobox next to 'Exec:' and click the 
'Advanced' button. The window is enlarged and you can select the predefined dialog 
window from a treeview. 
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Variables used in the dialog window must be defined in the calling routine. If  you 
execute a routine from a button in a dialog window, you need to declare all variables as 
non local in the routine definition (deselect the 'Local' flag in the 'Variable definition' 
window of  the Routine Painter).  

3.6.3 Dialog Windows Running Programs 

Dialog windows can be also used to create alternative interfaces to the standard 
application menu used for executing procedures. Using the 'Button' or 'Bitmap Image' 
button a new dialog window can be created that executes other dialog windows or 
programs belonging to the application. 
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When the 'Button' or 'Bitmap Image' button is clicked the integrated dialog window, 
program, or query/report defined in the 'Execute' field is executed. Digiting e.g. 
'GEST_ART' in the 'Execute' field the managing items procedure is executed. 

Dialog windows can be also created as application background. Bitmap images (.BMP 
files) are used as hyperlinks for program executions, when the 'Background' flag in the 
'Dialog Window Options' window ('Opt.' button) is active. 

 

Hyperlink areas are defined activating the 'Invisible' flag. The following picture shows 
an example. 
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3.6.4 Default Dialog Windows for Users and 
Groups 

 

 Dialog Windows used by potentially all users are saved simply clicking the 
'Save' or 'Save as' button on the 'Dialog Window Painter' toolbar. If  the dialog window 
must be displayed at the application's start-up, save it as 'Default'. 

 

 To restrict the use of  dialog windows to only specific users or 
groups, open the 'Utility' menu and select 'User Administration', or click the 'Users' 
button on the Application bar'. 
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To assign a dialog window to a group just drag&drop the desidered group on the 
Dialog Painter working window. The dialog window is saved as default for that group 
(default_g<group_no>.vfm). Similarly you can assign a dialog window to a specific 
user (default_<user_no>.vfm). Close the application and log-in as the selected user. 
The defined dialog window is displayed. 

3.6.5 Security Access For The Dialog Window 
Painter 

To avoid users and groups accessing the 'Dialow Window Painter' open the 'Utility' 
menu and select 'Procedure Security' or press <ALT>&<F12> while the 'Dialog 
Window Painter' is running. 
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Chapter 4  

Zoom Painter 

4.1 Introduction 

The 'Zoom Painter' deeply exploits object oriented technology. It integrates the 
'Query Painter' allowing to create interpreted zooms on multifile queries. 

4.2 The Zoom Painter 

To activate the Zoom Painter open the 'Utility' menu in your application and select 
'Zoom Painter'. An empty and resizable zoom window is opened. This window is 
divided in two areas: in the first area you can define the display layout of  the query; in 
the second area you can defined the query configuration. To open the configuration 
area press the 'Opt.' button on the 'Zoom Painter Toolbar'. 
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4.3 The Zoom Painter Toolbar 

The 'Zoom Painter' Toolbar has a set of  buttons that help you interacting with the 
tool: 
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Button Name Action 

 
New Opens a new Zoom (.VZM). 

 
Open Opens an existing Zoom (.VZM). 

 
Save Saves the opened Zoom. 

 
Save as Saves the opened Zoom with a different name. 

 
Exit Exits the Zoom Painter to go back to the application. 

 
Main Table To select the main table. 

 
Options To add Zoom options. 

 

4.3.1 New 

The 'New' button clears up the memory and opens a new Zoom. 

4.3.2 Open 

The 'Open' button opens an existing Zoom. Clicking this button the 'Open' window is 
opened and all files in the working directory having the extention .VZM are displayed. 

4.3.3 Save 

The 'Save' button saves the current Zoom. The Zoom name must be of  maximum 
eight characters. 
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4.3.4 Save As 

The 'Save As' button saves the current Zoom with a different name. 

4.3.5 Exit 

The 'Exit' button exits the Zoom Painter to go back to the application. 

4.3.6 Table 

The 'Table' button allows selecting the main table. Clicking the button the 'Table 
Selection' window is opened and application tables displayed. 

 

Selecting a table its fields and records are defaulted in the zoom dispaly area. 
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4.3.7 Options 

Clicking the 'Opt.' button the 'Options' window is opened, in which zoom options can 
be defined. 

 

In the 'Options' window you need to define the zoom title and the procedure that 
must be launched when the record is selected. 

4.4 Painting A Zoom 

Let us now analyze some simple examples for painting a Zoom. 

4.4.1 Table Selection 

The Zoom main function is to display a record of  a given table; hence the first thing 
you need to do is to select a table. Click the 'Table' button and select a table from the 
list. 

N.B. 

Before adding a zoom, which has been designed with the Zoom Painter, you need to define the 
reference table. 
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4.4.2 Painting The Zoom 

The fields and records of  the selected table are defaulted in the zoom display area. 
You can now select a Visual Query (previously created with the Query Painter) to be 
associated to the zoom in order to define the way extracted data is displayed. Click the 
'Options' button and go to the 'Query File' field in the 'SQL' tab-strip. 

 

Let us now analyze the various zoom areas. 

4.5 Display Area 

The 'Display' area is highly customizable and can be configured easily. Defaulted 
records are organized in titled columns. You can change the size of  this area so that 
you can display variable fields and add fixed fields ('Opt.' button). 
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4.5.1 Column Options 

Right click the column title to open the 'Column Title' window. 

4.5.2 Column Title 

In the 'Column Title' window you can define properties of  the displayed field. 
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Field 

This field contains the field name. 

Title 

The 'Title' field contains the column title. The defined string will be used if  the field is 
in a fixed position. 

Format 
The 'Format' field contains the picture of  the field. Please refer to Visual FoxPro 
manuals for the list of  pictures available. 

Height 
The 'Height' field defines the field height in pixel. The defined height will be used if  
the field is in a fixed position. 

Width 

The 'Width' field defines the field width in pixel. The defined width will be used if  the 
field is in a fixed position. 

Text Color 
The 'Color' field defines the field color. Colors must be defined using the Visual 
FoxPro RGB() functionality. You can also add logical conditions or expressions 
accepted by the Visual FoxPro language. 

Background Color 
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The 'Background Color' field defines the field background color. Colors must be 
defined using the Visual FoxPro RGB() functionality. You can also add logical 
conditions or expressions accepted by the Visual FoxPro language. 

4.6 Configuration Area 

The 'Configuration' area is activated clicking the 'Options' button. In this area you can 
define zoom parameters. 

 

The 'Configuration' area is divided in five tab-strips, namely 'Selection', 'Order By', 
'Fields', 'SQL', and 'File'. In the first three you can define charcteristics of  the SQL 
sentence. In the 'SQL' tab-strip you can check the SQL sentence you are building. 
Clicking the 'Query File' button you can select an existing query to be associated to 
the zoom. In the 'File' tab-strip you can save the defined paramenters in the zoom or 
create/ modify a report. 

Changes to the zoom can be checked immediately. Clicking the 'Query' button (next 
to the 'Options' button) the query is executed basing on current parameters. 
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4.6.1 Select 

In the 'Select' tab-strip you can define query expressions and/or further record 
selection parameters. Complex multiparameter query expressions can be defined using 
the operators in the second column, or the boolean operator 'OR'.  

 

Fields are dragged&dropped from the selection columns in the 'Display' area. The 
comparison operator is selected double clicking the desidered one in the second 
column, or dragging it on the selected field. To select the boolean operator click the 
'OR' button. 

4.6.2 Order By 

In the 'Order By' tab-strip you can define the field order simply dragging&dropping 
fields from the selection columns in the 'Display' area. By default fields are ordered in 
ascending order. Double clicking the field the order changes to descending. 

 

The 'Delete' button allows deleting fields from the 'Order By' list. 
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4.6.3 Fields 

The 'Fields' tab-strip displays the list of  fields that are displayed in the  'Display' area. 
The right column displays excluded fields. Fields can be moved clicking the '<<' or 
'>>' buttons. 

 

4.6.4 SQL 

The 'SQL' tab-strip contains the SQL sentence defined for displaying extracted data. 
Associating a Visual Query to the zoom you can notice that the 'WHERE' clause is 
replaced by the query name. 

 

Clicking the 'Query File' button you can select an existing Visual Query (*.VQR). You 
can also edit the SQL sentence activating the 'Edit SQL Sentence' flag and make 
manual changes. 
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4.6.5 File 

In the 'File' tab-strip you can save the parameters defined in the zoom or create/ 
modify a report. 

 

When the 'Default' flag is active, the current configuration is used as default. When 
the 'Ask For Parameters' flag is active, and the zoom is executed, a selection 
parameters window is opened. When the 'Keep Dimensions' flag is active the dialog 
window dimensions are saved in the configuration file. 

Clicking the 'Save' button the configuration is saved using the following syntax: 
<ConfigurationName>.<TableName>_VZM

Clicking the 'Modify/Create Report' button the MS Visual FoxPro Report tool is 
launched. The report can thus be associated to the zoom. The configuration is saved 
with the following syntax: 

<ConfigurationName>_<TableName>.FRX

The associated report can be called clicking the 'Execute Report' button in the 'User' 
area (for more information please refer to 'User Area'). 



V I S U A L  T O O L  G U I D E

Z O O M  P A I N T E R  1 0 9  

 

Clicking the 'Create/Modify MS Word' button MS Word is opened and a model is 
created (<ConfigurationName>_<TableName>.DOC) on which extracted data is 
merged. For more information please refer back to Chapter 2 - 'Query And Reporting 
Tool'. 

4.6.6 User Area 

The 'User Area' on top of  the tab-strips has a set of  buttons that help you interacting 
with the zoom. 

 

Ask For Parameters 

The 'Ask For Parameters' button launches a selection dialog window. This window is 
created basing on parameters defined in the 'Selection' tab-strip. If  no parameters have 
been defined a warning message appears. 
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Settings 

Clicking the 'Settings' button you can select an existing configuration file. 

Execute Report 
Clicking the 'Execute Report' button a dialog window is opened in order to select the 
device on which the report must be run. 

 

For further information please refer to the 'Programming And Utilities Guide'. 

Recalculate Report 
Left clicking the 'Recalculate Report' button the last query is re-executed. Right 
clicking the button, configuration paramenters are cleared. 

4.7 Tool Insight 

First of  all let us see how many routines build the 'Zoom Painter'. 
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Procedure Function 

VZ_BUILD.PRG To design the query. 

VZ_EXEC.PRG To execute the zoom functionality. 

STD.VCX and .VCT Class libraries for the tool. 

 

The VZ_BUILD.PRG procedure allows drawing and building Zooms. It creates 
.VZM files containing the zoom structure. The created Zoom is automatically added 
to the 'Utility' menu. 

Zoom can be executed directly from the tool clicking the 'Query' button in the 
configuration area, or directly from the menu or simply calling the 'VZ_EXEC' 
procedure, defining the zoom name between apexes. The tool identifies the correct 
translator basing on the file extention. 

N.B. 

If  the 'Name' field is left empty a selection window is opened, from which zoom files can be 
selected. 

Exercise 

do vz_exec with 'prova'

Execu tes  the  'p rova '  zoom.  

do vz_exec

Opens  the  'Open '  w indow  f rom wh ich  the  zoom i s  s e l ec ted  ( .VZM 
ex t ent i on) .  

VX_EXEC with '<ZoomName>.VZM'

Bas ing  on  the  f i l e  ex t ent i on  .VZM the  t rans l a to r  execu tes  the  zoom 
'<ZoomName> '  f rom the  menu.  
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4.8 Integrating The Zoom In The 
Application 

Visual Zooms can be integrated in the application. They can be executed clicking a 
button or directly from the menu. Let us now see some examples. 

4.8.1 Visual Zooms And Buttons 

Buttons can be added to any applications' entity. Visual Zooms can be executed from 
a button simply going into the 'Button Options' window, setting the ' User Tool Kit' 
flag and digiting the zoom name in the 'Execute' field. 
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4.8.2 Visual Zoom With Selection 

Visual Zooms can be also used to select records that will be the basis for subsequent 
data extractions. This is achieved through the use of  the routine CP_SZOOM.PRG. 
This routine can be called from the 'Routine Painter' only. Required parameters are: 
name of  the cursor that is created with the extracted records, name of  the table on 
which the zoom is pointed, the zoom title and, if  desidered, a configuration file name. 
The same applies for multifile qeries. 
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A selection zoom can be called from within a routine simply defining the following 
'Execute Statement': 

Cp_szoom (<i_cCursor>,<i_cFileName>,<i_cZoomTitle>,<i_cZoomFile>)

Or

do Cp_szoom with
<i_cCursor>,<i_cFilename>,<i_cZoomTitle>,<i_cZoomFile>

where 

<i_cCursor> 

Is the cursor name created with selected records. 

<i_CFileName> 
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Is the table name in which the zoom works. 

<i_CZoomTitle> 

Is the zoom window title. 

<i_CZoomFile> 

Is the configuration file name. 

The file<i_cZoomFile>.<i_cFileName>_vzm. is opened by default. If  the 
parameter is not defined it searches:default.<i_cFileName>_vzm. If  no 
configuration file is found, all table fields are displayed. 

4.8.3 Visual Zoom From Menu 

Visual Zooms can be executed from the menu adding the call command to 
VZ_EXEC and defining as parameter the zoom's name between apexes. 

The procedure VX_EXEC can also be executed from the menu. Basing on the 
extention the correct translator is launched. 

N.B. 

If  the zoom name is not specified the 'Open' window is opened and the desidered zoom can be 
selected. 

Exercise 

do vz_exec with 'MyZoom'

Execu tes  the  'MyZoom'  zoom.  

do vz_exec

Opens  the  'Open '  w indow  and  the  zoom that  mus t  be  executed  can  be  
se le c ted  ( .VZM ex ten t ion) .  

VX_EXEC with "<ZoomName>.VZM"
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I f  the  ca l l  c ommand i s  added to  the  menu the  t rans la to r  execute s  
<ZoomName> bas ing  on  the  ex tent ion  .VZM  

 

4.9 Limited Access To The Zoom 
Painter 

To limit or deny access to the Zoom Painter open the 'Utility' menu in your 
application and select 'Procedure Security' or press <ALT> <F12> when the 'Zoom 
Painter'is opened. For further information please refer to the 'Programming and 
Utilities Guide'. 
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Chapter 5  

Menu Painter 

5.1 Introduction 

Using the 'Menu Painter' you can customize menus at user level by simply designing 
the menu structure. Basing on the default menu you can change the menu order, limit 
or deny access to certain functionalities, or create custom configurations. 

5.2 The Tool 

Run your application, open the 'Utility' menu and select the 'Menu Painter'. The 
'Visual Menu' window that is opened is divided in three sections: the 'Default Menu' is 
displayed on the right and the menu you are about to create on the left. Under these 
two sections you can change the procedure name and test the menu while you create 
it. 
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5.3 The Menu Painter Toolbar 

The 'Menu Painter' Toolbar has a set of  buttons that help you interacting with the 
tool: 
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Button Name Action 

 
New Opens a new menu (.VMN). 

 
Open Opens an existing menu (.VMN). 

 
Save Saves the current menu. 

 
Save as Saves the current menu with a different name. 

 
Exit Exits the Menu Painter to go back to the application. 

 

5.3.1 New 

The 'New' button clears the memory and opens a new menu. 

5.3.2 Open 

The 'Open' button opens an existing menu. 

5.3.3 Save 

The 'Save' button saves the current menu. 

5.3.4 Save as 

The 'Save As' button saves the current menu with a different name. 

N.B. 
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You can save created menus in the subdirectory 'Menu'. During the Design Phase the tool will 
search for .VMN files under this subdirectory. Before launching a menu from a procedure you 
need to define the correct path. 

5.3.5 Exit 

The 'Exit' button exits the Menu Painter going back to the running application. 

5.4 The Default Menu 

The 'Default' menu is displayed in the 'Default' area. The menu structure reflects the 
project design. The 'Default' menu can be changed using the 'Menu Painter'. These 
changes are then always displayed in the 'Default' area. Menus are organized in 
directories (menu items), subdirectories (submenus) and 'files' (procedures). 
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 Submenus are opened double clicking the folder in the treeview. Similarly 
submenus are closed double clicking the folder. 

The custom menu is build simply double clicking the desired procedures or menu 
items in the 'Default' area. The selected menu item or procedure is copied in the area 
on the left. 

N.B. 

Selected items are always copied under tha last highlighted item on the left. 

N.B. 

Custom menus can be saved under the directory 'Defaults'. During the 'Design' phase the system 
will search for .VMN files under this directory. Before launching the menu from a procedure you 
need to define the correct path. 

Exercise 

The 'De fau l t '  menu has  th r ee  i tems,  name ly  ' I tems ' ,  'T ransac t i ons '  and  
'Repor t s ' .  You  a re  requ i red  to  bu i ld  a  cus tom menu  conta in i ng  t he  i tems  
' I tems '  and  ' T ransac t i ons ' .  Ac cess  to  ' Repor t s '  mus t  be  den i ed .  F rom the  
'De fau l t  Menu '  doub le  c l i ck  ' I tems ' .  Go to  the  'Cus tom '  a rea  and  se l ec t  
'Menu ' .  Go  back  to  the  'De fau l t  Menu '  and doub le  c l i c k  'T r ansac t ions ' .  

 

5.5 The Menu Item 'Customizations' 

One of  the items of  the 'Default Menu' is 'Customizations'. This menu has four 
submenus, namely Menu, Dialog Window, Report, and Zoom. 
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Each submenu item contains the files created with Visual Tools available in the 
application. These files can be launched directly from the application's menu. Custom 
queries and reports can thus be associated to specific users. 

5.6 The Custom Menu 

When you open the 'Menu Painter' the 'Custom' menu contains the 'Main Menu' item 
only, which is the basis for building menu customizations. 
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On top of  the 'Custom' menu there are five buttons that help you building your menu 
customization: 

 

 Clicking the 'Menu' button you can add a new folder to the menu structure. 
The default name of  added folders is 'New Menu'. 

 

 Clicking the 'Option' button you can add options to a folder, i.e. 
commands or procedures. The default name of  added options is 'New Option'. 

 

 Clicking the 'Separator' button you can add dividing rows between 
submenus. This improves the menu's layout and groups submenu items that are 
logically linked together. 
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 The 'Seq.+' and 'Seq.-' buttons allow you changing the menu items' 
order. If  you select a menu item and click the 'Seq.+' button the item is moved 
downwards. If  you select a menu item and click the 'Seq.-' button the item is moved 
upwards. 

Exercise 

You r  menu has  t h ree  i tems :  ' I t ems ' ,  'T ransac t ions '  and  'Repor ts ' .  The  
'Repor t '  menu mus t  be  moved between  the  o the r  two.  Se le c t  the  'Repor t '  
in  the  'Cus tom'  a rea  and c l i ck  the  ' Seq . - '  bu t ton .  The  'Repor t '  i t em i s  
moved  upwards  be tween ' I tems '  and  ' T ransa t ions ' .  

 

5.6.1 'Entry Title' And 'Procedure Name' 

In the area under the two menus there are two text boxes: 'Entry Title' and 'Procedure 
Name'. These allow changing the menus and procedures descriptions as well as the 
names of  functions/ procedures in the menu. 

 

Select any menu item in the 'Custom' area. Its description is defaulted in the 'Title 
Name' text box. You can now change the description string. Similarly you can select a 
menu option and change its name in the 'Procedure Name' string and its description 
in the 'Title Name' string. 

Exercise 

You r  menu has  t h ree  i tems :  ' I t ems ' ,  'T ransac t ions '  and  'Repor ts ' .  You  are  
requ i red  to  rename 'Repor ts '  in  'Repor t i ng ' .  Se l ec t  the  'Repor t '  menu i n  
the  'Cus tom'  a rea .  I n  the  'T i t l e  Name '  tex t  box  d i g i t  ' Repo r t ing '  and  in  
the  'P rocedure  Name '  d ig i t  ' V I SREP ' .  
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5.6.2 The 'Try' Button 

 

 Next to the two text boxes there is the 'Try' button that allows testing the 
created menu. Clicking it temporarely creates the defined menu. The button changes 
to 'Recover'. 

 

 Clicking the 'Recover' button the default menu is recovered and the 
button changes again to 'Try'. 

5.7 Saving Visual Menus And 
Managing Users 

'Custom Menus' can be saved as default or can be restricted to specific users only. 

 

 Clicking the 'Save' or 'Save As' buttons you can save the customized menu. 
If  the menu must become the default menu digit 'DEFAULT' in the file name. The 
menu is saved as DEFAULT.VMN and is the defaulted menu for each user. 

To associate the menu to a group of  users open the 'Utility' menu and select 'User 
Administration' or click the 'Users' button on the 'Application' bar. 

 

The 'User And Group Administration' window is opened detailing all users and all 
groups. 
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To associate a menu to a group of  users drag&drop the group's name on the opened 
'Custom' menu. The system will automatically save the menu as the default menu for 
that particular group (Default_G<usergroup number>.VMN). When one of  the users 
belonging to the group log-in the application the system will determin which menu 
must be used. The system will first check whether a personal menu exists for that user 
(Default_<user number>.VMN). If  no personal menu is found the system checks if  
the user belongs to a group that has a customized menu (Default_G<usergroup 
number>.VMN). If  no group menu is found the default menu is displayed 
(Default.VMN). 

Only the System Administrator can associate menus to users and groups. 

N.B. 

Menus can be saved under the directory 'Default' (for large applications the subdirectory must be 
created under the EXE directory). The system will search for .VMN files under the main 
directory first and in the 'Default' subdirectory afterwards. The Customization menu displayes 
both, menu configurations under the main directory and under the subdirectory 'Default'. 


